(BUSSLINE is the term for the complex multifunctional circuitry on a computer motherboard, a PC’s heart.)
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All you Ever Wanted to Know
about Recycling Tech Items
Dave Archard, Procurement Manager of Orlando Recycles, Inc., will speak at our April 17 General Meeting on the state of the art of recycling.

are now moving back to the Lee Rd. office of
Jackson Hewitt. For details and maps, turn to page
24, or consult our website at cfcs.org.

This is a relatively new Company, about one year
old. Their name WAS International Recycling and
Liquidation Service, which they have just recently
changed to Orlando Recycles, Inc. If you just can‟t
wait until the meeting, you can learn more at their
web site - it is http://www.orlandorecycles.com.

Also, earlier on the same day of each general meeting, the Windows SIG* meets.
(*Special Interest Group) The WinSIG always gathers at 12:30 pm, just before the CFCS General Meeting.

CFCS has just named them as our “CFCS Preferred
Recycler” - there will be more details on how this all
works at the meeting and in the “Recycling Bin” by
Stan Wallner, on page 2.
Mr. Archard will have a small truck AT THE
MEETING, so if you have a monitor or PC or two
that you want to get rid of RESPONSIBLY, please
bring them along. It is better than free Recycling CFCS will even get a small payment for your donation!
Yes, they are willing to PAY CFCS for what our
members recycle with them! It'll be variable, based
on what we drop off, but no one else does this! The
BOD has OK‟d this!
If you‟d like to bring more than a few small items
please email presidentemeritus@cfcs.org so we can
coordinate.

Don’t forget that our 3rd Sunday meetings

If you use or plan to use Windows, these discussions,
demonstrations, and Q&A sessions will be of immense value to you. Geared to intermediate level
Windows users. Tips, tricks, and information on all
versions of Windows are discussed. An e-newsletter
is sent periodically with meeting information and
links discussed at the meeting. You need not attend
both meetings, but many members do. Non members
always welcome. Sign up for the free e-newsletter at
cfcs.org.
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Special Interest Groups (SIGs)
The iSIG meets every third Monday at 7:00
pm at Denny's on Lee Rd & I-4. The iSIG meetings
cover the products that use the iPhoneOS, which
includes the iPhone, iPad, and iPod. This is a combined effort of the Central Florida Computer Society http://www.cfcs.org and the Florida Macintosh Users Group http://www.flmug.com. Other
groups are invited to participate. Attendees are
consumers, developers, consultants, and publishers. The SIG leader is Sean Kane, Certified Apple
Technical Coordinator, long-time Mac and iPhone
user, and a technologist and consultant to Walt
Disney Feature Animation Florida.
Please note that the iSIG meets at the Denny's on Lee Rd. The Tech-SIG and the Board of
Directors meetings continue to meet at Denny's
on 436 & Oxford Rd in Casselberry.
The ACCESS, MS OFFICE, and SECURITY SIGs meet conjointly on the second Wednesday of each month from 7 to 9 pm at the New Horizons Learning Center at 1221 Lee Rd. Arvin
Meyer, a Microsoft MVP (Most Valuable Professional), (and current CFCS president), leads the
SIG. http://groups. yahoo.com/group/cfcs-access
This is a combination of three separate SIGs which
now meet alternately for the duration of Arvin‟s
presidency. They will resume separate meetings
when he leaves office and/or publishes his upcoming book.
The GRAPHICS/PHOTO SIG meets on the
third Wednesday of each month from 7 to 9 pm at
the New Horizons Learning Center at 1221 Lee
Rd. Robert Black, CFCS newsletter editor, is a former archaeological photographer and teacher. Email: graphic-sig@cfcs.org
This SIG concentrates on digital photography and any software or peripherals related to it.
Whether you are a beginner or a pro, bring your
stuff (gear & photos) to show off or ask questions

SIGN UP FOR WEEKLY E-MAIL!
All meetings and speakers are subject to
change, and late alterations are always possible. To keep completely on top of events,
log on to CFCS.org and subscribe to our
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so we can learn from each other!
The TECH DISCUSSION SIG meets on the
fourth Tuesday of each month from 7 to 9 pm at the
Casselberry Denny‟s at 436 and Oxford Rd.
This SIG is a non-structured, open conversational
group for CFCS members, that has no specific topic
or speaker, but is simply a round table discussion. It
is not an advanced group, but a place for people to
come and discuss various subjects, such as new products and technologies, hardware, software, webrelated, etc. Bring in articles from magazines, newsletters, unusual problems/situations that have arisen,
questions, etc. Also, new or ailing devices or notebook pc's are welcome, either for "show and tell" or
discussion or demo of situations. E-mail: techsig@cfcs.org

The Recycle Bin
by Stan Wallner,
President Emeritus, CFCS
This a separate, continuing monthly
column. Check here regularly for updates and new
info.
This a MOST important issue regarding our
environment; and can't be over-emphasized! It is an
area that is changing frequently, so please keep
reading this column regularly!
Regarding you bringing items tome - if you have a
few items for any of the following places, let me
know. If I know well in advance so there aren't too
many items on any one day, I‟ll agree to have you
bring them to a General or one of my SIG meetings
(especially out-of- towners), and I'll take them from
there. I DO need to know in advance. AND, I do
plan to do a lot less of this now that there are more
options.
Category "A"
For Monitors, Printers,
Scanners that still work, and PC's that are
repairable)
# 1 Orlando Recycles, Inc is now the CFCS
PREFERRED and RECOMMENDED Recycler!
WHY? We have worked out what should prove to be
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a win-win situation for both of us, with absolutely no
risk involved for either of us! They are willing to
PAY for we what we recycle with them! It will be
variable, based on what we drop off, but no one else
has offerred to do this, and the BOD has authorized
me to pursue this. AND, they will do the same for
items that DO NOT work, so they do truly fit in both
Category “A” AND “B!!”
They are at located at 5014 Forsyth Commerce Road,
#4, Orlando, FL, 32807, just off Forsyth, about 1/2
mile east of 436 and Colonial. Their hours are from
9:00 to 5:30. You do not need to call them. If you
are near them, and want to take things on your own just go there and ask for Tracy, their Operations
Manager, say you are involved with CFCS, and she
will make sure that whatever you drop off gets
tagged, and entered towards CFCS's credit into a
spreadsheet. Then, whether monthly (or quarterly if
amounts are small and take a while to build up), the
value they assign to what you dropped off will be
mailed to CFCS!! What could be easier! Why not
help CFCS? Yes, Missionary PC's, Goodwill and
others are worthwhile, but not very helpful to CFCS,
Best Buy, Staples and others will even charge you!
Why not use these folks - CFCS will gain!
The other cool thing about this arrangement is that
Dave Archard, their Procurement Manager (who
decides the value of what is left there and will be
sent to us), just happens to live near ME, and does
not mind coming to my house to get stuff in his van
or pickup truck! So this means you can bring items
to one of our meetings (with co-ordination as mentioned before), we put it MY van, and he'll come get
it from me - MUCH easier for everyone! (And, I
have frankly gotten tired of doing this on my own.)
# 2 Missionary Computer Fellowship (MCF), 401
S Magnolia Ave, Orlando, FL;
Phone: (407) 422- 9265.
This was a major organization doing refurbishing
and rebuilding, It was associated with and located
in the First United Methodist Church downtown.
They were not completely religiously oriented. They
used to send reconditioned PCs to missionaries all
over the world, as well as poor villages in Africa,
etc., but we have just received word that they will
soon be closing shop, due to the church‟s moving to
new premises with insufficient room for their work.
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#3 Southeastern Data, at 142 Park Road, Oviedo,
FL 32765 (Off Alafaya Trail, just north of E.
McCulloch Road); phone 407-971-4654.
They've been very helpful in allowing CFCS
members to drop off most recyclables with no service charge for quite some time; greatly appreciated!
(There ARE places that do have fees to recycle all
items - I am not going to include them in this column) They offer free recycling to CFCS members
with the exception of CRT monitors, terminals, and
some TVs. CRTs and terminals are $3.00 each. TVs
need to be evaluated, but most are free. It is best to
call before you take items there to be sure you don't
arrive at a bad time, Also, do let them know you are
involved with CFCS. Southeastern Data is also a
great place to pick up parts and accessories, and they
accept trade ins against purchases. In some cases
they will even outright purchase your components.
Their hours are 8:00 am til 5:00 pm, Monday thru
Friday, with other hours available by appointment.
#4 Goodwill
They have recently changed their policy, and WILL
now accept WORKING Monitors including CRT‟s
if not too old, Printers, Scanners, PC's, DVD, CD or
Hard Drives at all of their locations, including the
manned Trucks around town.
#5 Salvation Army
Not sure; contacting them; stay tuned.
#6 Vietnam Vets
Not sure; contacting them; stay tuned.
Category "B" - Scrap - For Monitors, Printers,
Scanners that DON'T work, and PC's that are
too old, and/or NOT repairable)
#1 Best Buy Stores
New to us! All local stores; no need to contact them
first. All items above; all at NO CHARGE, limited to
three items per visit. The only exceptions are CRT
Monitors or TV's. First, there is a maximum size of
32", and there will be a fee of $10.00 each. However,
they do immediately return the $10.00 to you in the
form of a Cash Card! You can go to
www.bestbuy.com/recycling for more info, or
CALL - we're available 24/7' at 1-888- BEST BUY
(1-888-237-8289)!
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#2 Recycling Directory: http:// earth911.com/
Earth911 is a directory containing information for
recycling over 240 different products that are free for
consumers. There are over 127,000 locations and
programs that people can search to find local
recycling and disposal resources. Thanks to Mike
Ungerman and Hewie Poplock for sending this to me
- includes County places, and for example - Staples,
many others, by ZIP. It is thorough! (What is not
mentioned on this site, again. for example, is that
Staples CHARGES $10 EACH for any PC, Printer,
CRT or LCD , even Hard Drive! Only small items,
such as mice and keyboards are free. So I would say
―caveat emptor ― applies! Call or go first, as I did!
We will be adding to this list. There are many additional places, and we want as many listed here as is
possible for our members‟ convenience! If you have
suggestions or comments, send an email
to presidentemeritus@cfcs.org.
My suggestion is that you consider the new #1 in
Category A, Orlando Recycles, Inc and that you
work through me as suggested above - that is the
ONLY way that CFCS benefits!
==============================
Stan, a CFCS member since 1984, has served in many
offices over the years, and is now on the BOD as
President Emeritus. Separately, he is a local IT
consultant, "PC Doctors Make House Calls,"offering his
services on-site, at your office or home - for PC and
Laptop Upgrades, WiFi, Networks, Virus & Spyware
removal, Troubleshooting both hardware
& software, at reasonable rates (discounts for CFCS
members!).
You
can
contact
him
at
smwallner@yahoo.com or 407-862-2669.

Agreeing to Disagree
By Hewie Poplock,
Board of Directors – APCUG,
Vice President – Central Florida Computer Society,
Vice President – Fraternal Order Of Eagles, Aerie #4449,
member Curriculum Committee, LIFE at UCF

You are at your User Group meeti ng, or any
volunteer organization, and someone comes up to
you asks for you to run as an officer or a member of
the Board. You are honored, hesitant about being
able to do a good job, but you agree. You are elected
and excitedly attend your first officers‟ meeting.
Someone, and it could be you, makes a com-
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ment or a motion that generates a lot of discussion.
Then the discussion gets heated and personal. This
happens more often in e-mail discussions between
the officers. When it does happen, you ask yourself,
“What did I get myself into?”
When situati ons like this occur, and they do in
every volunteer organization, it is best not to get too
passionate about your view or opinion. There are
many things that you need to remember.
The governing body is made up of many people, each of whom has their own opinions, their own
goals, their own idiosyncrasies, and their own ego. If
the board all thought alike, then you would only need
one member to make the decisions. You have your
own approach to solving a problem, as does each
member of the group. They are seldom alike.
Everyone needs to agree to disagree and once a
decision is made by the majority, live with that decision. On other issues, your side will win. That is the
way it should be. However, we all have been members of groups where some who don‟t get their way,
launch a campaign to attack the issue, the decision,
“take their toys and go home”, and worse, get personal with the people that voted for the item. Sometimes it gets downright dirty and nasty.
Before your group gets to this point, talk about
the problem. You should always start each new term
of your board with the topic that will you agree to
disagree, but will accept decisions of the majority
and will support those decisions.
At the end of discussions, no matter how heated, you should be able to have a cup of coffee or a
beer and talk about your family, a movie, or try to
solve a nagging computer problem. Don‟t dwell on
your differences from the meeting.
U.S. Congress members fight on the chamber
floors, on TV and then go to cocktail parties together. We should be able to do so, as well. Remember
that we are all volunteers. We all have feelings.
Some officers have stronger personalities, but we all
have opinions and they should be respected by each
member.
Let‟s agree to disagree, but remember that the
user group or organization is made up of the members and the officers and board members are making
decisions that affect every member and the purpose
of the decision should benefit the group, not just you.
Feel free to read this at your next officers‟ meeting
and use it as a discussion item.
-Reprinted from the April - June 2011 APCUG
Reports
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THE CENTRAL FLORIDA COMPUTER SOCIETY is a
charitable, scientific and educational, nonprofit organization,
founded in 1976 and incorporated in 1982 to encourage interest in
the operation and development of computers through meetings
with free exchange of information and educational endeavors.
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Board of Directors
President

Arvin Meyer

407-327-3810

president@cfcs.org

Vice Pres.

Hewie Poplock 407-362-7824

vicepresident@cfcs.org

Secretary

Bess MacConnell 407-644-3852

secretary@cfcs.org

Newsletter: The CFCS Newsletter © 2008 is the official
newsletter of the Central Florida Computer Society, Inc. It is
published every month by CFCS for the purpose of keeping
members and others informed of computer-related news and
activities of the Society. Circulation: 25,000.

Treasurer

Carlton Jacobs 407-328-2766

treasurer@cfcs.org

Director 1

Jack L. Pearson 407-880-7339

dir1@cfcs.org

Director 2

Ted Goodwin

407-894-1180

dir2@cfcs.org

Director 3

Forrest Cheek

407/629-4139

dir3@cfcs.org

Mailing Address:
CFCS
204 Larkwood Dr., Suite 100
Sanford FL 32771
Membership: CFCS membership includes participation in the
Society's activities and subscription to this Newsletter.

Newsletter Editor

Robert Black

407-421-4213

editor@cfcs.org

President Emeritus

Stan Wallner

407-862-2669

presidentemeritus@cfcs.org

SIG Chair

Ken Larabee

407-365-2660

sigs@cfcs.org

Chairpersons and Coordinators
Special Interest Groups

Ken Larabee

APCUG

Quirt Alrich

Education
FACUG
Hardware Manager
Helpline Volunteers

(Open)
Quirt Alrich
Arvin Meyer
Griff Moore

(e-mail only)

Members are responsible for sending a change-of-address
notification (including e-mail) to:
membership@cfcs.org.

Membership
Photographer

Jay Jacobs
Robert Black

407-328-2766 membership@cfcs.org
407-421-4213) photographer@cfcs.org

Gifts to CFCS are welcome, and because of the Society's nonprofit
tax status, are tax deductible.

Program Coordinator
Reviews (S/W & Books)

Hewie Poplock
Mike Ungerman

(e-mail only)
(e-mail only)

programs@cfcs.org
reviews@cfcs.org

Webmaster

Cheryl Wilson

(e-mail only)

webmaster@cfcs.org

Annual Dues Schedule:
Individual ……………………….$
Extra family member ..…….…..
Student (Full time)………………
Corporate membership……..…..
*Includes free business card ad

40
24
24
132*

Meetings: CFCS meets each month on the 3rd Sunday at 2:00
p.m. at the Jackson Hewitt Training Center, 2221 Lee Rd.
Winter Park, FL The Jan. Feb. and Mar. meetings are held at
the University Club of Winter Park. Guests and the general
public are invited to attend. Special Interest Groups (SIGs) within
the Society meet regularly. See Special Interest Groups listings on
pages 6 & 7.
CFCS Web site:

Editorial: Articles for publication in the CFCS Newsletter should
be emailed to the Editor at: editor@cfcs.org. Please use Microsoft
Word format, Times New Roman font, 12 point, if possible. The
deadline for submitting articles is the first of each month.
Articles by authors other than directors of CFCS and the
Newsletter staff do not necessarily reflect the policies or sanction
of the Society. Unless otherwise indicated, articles in the CFCS
Newsletter may be reprinted in newsletters of other nonprofit
organizat-ions, without permission, provided credit is given.
This issue was created using Microsoft Office
Publisher 2003 Edition. ◙

2003 and MS

Interested in making a difference?
Then volunteer with CFCS! The programs and
benefits that members receive would not exist
without members also volunteering. There are
vacancies for a Program Chair/Coordinator, Education Chair and Advertising Chair. Please contact Stan Wallner, if you have any questions,
comments, or suggestions. president@cfcs.org

apcug@cfcs.org
education@cfcs.org
facug@cfcs.org
407-327-3810 hardware@cfcs.org
(e-mail only) helpline@cfcs.org

Newsletter Committee
Editor: Robert Black
Associate Editor:
Proofreader: Ted Goodwin
Distrib: Stephen Constant

www.cfcs.org

407-365-2660 sigs@cfcs.org

Advertising: (Needed)

CFCS Newsletter Advertising
Computer ready rates, for one time insertion, whether in the Printed or
Electronic Edition:
Full Page
$200.00*
Quarter Page
$75.00*
Half Page
125.00*
Business Card
25.00*
Advertising deadline: the first day of month of issue. Electronic copy is
required.
All ad copy and correspondence should be sent by email to: advertising@cfcs.org
*Annual Rates, Paid in Advance, for 12 insertions, with a minimum of 2
Printed
Editions: Full Page
$1200*
Quarter Page
$450
Half Page
750
Business Card
150
*Does not include Back Page; please inquire if interested

CFCS is associated with both
International & Florida User Group Associations:

www.apcug.net
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time for a question and answer period. CFCS really had some good questions to ask and it took the
both of us to find some of the answers.

A Skype Webinar
with CFCS
By Marie Vesta
Last month, Hewie Poplock (vice-president of Central Florida Computer Society) asked if I would do a
webinar on the subject of Skype for his local group.
This was a presentation that I presented at the Northwest Florida Computer Association that turned out to
be very successful and well accepted.
So, after he and I talked, we decided to try this
presentation on the “Ins and Outs of Skype” using
Skype. Hewie and I had a test session to see how
sharing my PowerPoint presentation would work by
sharing this file. It worked great! Sharing files is a
very easy thing to do using Skype.
After my PowerPoint presentation, Hewie and I took

MEMBERSHIP RENEWAL
Membership renewal e-mail letters will be mailed from: membership@cfcs.org to members at their e-mail address of record
the month before their membership expires. Then, letters will
be snail mailed to members for whom no e-mail address is in
the membership database and those members whose e-mail
was returned to membership@cfcs.org for any of many possible reasons: no account, account inactive, mail box over limit,
spam filter intervention, etc. Please help us by adding this address to your contacts list and setting your spam filter to let our
message get to your inbox. We do not share your e-mail address with others (We hate that too!), but it is necessary for full
participation in the Society, including receiving your newsletter.
Members will be requested to renew their membership by paying dues on time.
If you do not receive a renewal letter, lose it or have questions
about your dues and or membership status, please inquire at the
sign-in table or send an e-mail to: membership@cfcs.org.
Membership Cards: A new membership card with an expiration date for the next year will be distributed at the meeting
following your renewal. The cards will be laminated and include a bar code which represents the member ID number.
Members are requested to present their membership card for
bar code scanning at the membership table to reduce the checkin time and make recording of attendance data easier. Cards
will be mailed to those members who request same by e-mail
to: membership@cfcs.org
New Member & Visitor Orientation: Please listen for an
announcement, at the beginning of the meeting for a time and
location.
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◙

Once the Q&A was finished, Kathy Jacobs
(APCUG President) joined us via Skype. We had
her join our presentation using the group video
conferencing aspect of the program. This really
opened some of the participant‟s eyes realizing
how this part of Skype could work with their families that live in different states. Having three or
four family members using Skype at the same time
and enjoying not only talking but seeing one another means a lot to everyone, especially Senior
Citizens.
The bottom line about this little story is how great
using “webinars” can be. APCUG is offering a variety of these and are available to any User Group.
If you need to have a quick presentation, be sure to
check and see what APCUG has available.
-Reprinted from the April - June 2011 APCUG
Reports

Photoshop World Convention
By Ken Larrabee
As a member of the National Association of Photoshop Professionals I am always interested in anything new or different in the Photoshop software
and since the CS5 issue has been out there have
been a number of new things to learn. With that
membership I received a complementary two day
pass to the NAPP Photoshop World convention at
the Orange County Convention Center.

April, 2011

CFCS BUSSLINE NEWSLETTER

PAGE 7

CD and DVD applications at reduced rate.

As you would guess the show was a photographer‟s
and Photoshop user‟s extravaganza in terms of who
was there and what was available to show. The Adobe area was impressive and they provided quite a
number of people to answer questions as well as a
running tutorial section on the various Adobe programs, not just Photoshop. I sat through a 40 minute
presentation about the changes in Premier Pro and
how much of it has been automated in the new 64 bit
CS5 version. While most of Adobe‟s software is either 32 or 64 bit, Premier Pro only comes in the 64
bit version now.

Kelby Training was the sponsor of the event and they
had a huge training area for Photoshop only. I
stopped for a while to listen to the presentation and it
was clear that between Adobe and Kelby there weren‟t any unanswered functions in the Photoshop application. In fact at the time I went by they were talking about an application that I had only seen used
once before. They also were selling their training

Other Photoshop application plug-in sellers were
there also. Each of the big ones: NIK, OnOne and
Topaz were providing training and workshops as
well as offering individual programs and suites for
considerably reduced cost. The Topaz group was
allowing up to five installations from one suite disk
and had reduced the price by $100 dollars. OnOne
software has changed the name of their picture enlargement program from Fractals to Perfect Resize.
That particular program is amazing at what the quality of the enlarged pictures retain from a simple jpg
picture.

For photographers they had models at various small
“studio sets” by Westcott for practice and evaluation.
They also sold the gas filled lighting sources for the
sets in various strengths and colors along with diffusers and studio gear. None of the standard filament
bulbs were there!
Other booths and kiosks were run by Xerox, Canon,
Adorama, Epson, Wacom and Manfotto. Some of
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these names do not mean a lot to non Photoshop users but they were fun to visit and certainly well informed!
Be sure to attend the Photo SIG on April 20
(7pm, New Horizons) to hear more from
Ken Larabee about the Photoshop World
Convention.

Legacy Family Tree Basics,
Part 1
By Bill Ellis, Regular Newsletter Contributor,
Computer Users of Erie, PA December 2010
issue, Horizons, The Official Journal of CUE
www.cuerie.com
cuerie1 (at) verizon.net
Legacy Family Tree Genealogy software
http://www.legacyfamilytree.com/

Stop, look and learn. Our hectic life has programmed us to get things done quickly. After all,
there‟s so much to do and so little time. As an example, I work on my family history almost every
day. If I‟m not researching my family tree, then I‟m
entering newly found information into my genealogy program. I‟m doing this all the while I‟m trying
to maintain a home and family, which I‟m sure you
know consumes a lot of our time. With all these demands, we tend to hasten through most of our least
important tasks so we can give more time to the important stuff. At the end of the day, we also would
like a little time to relax and unwind.
Even though we enjoy on our computers, I think our
computer tasks fall into that least important task list.
Hence, we get the computer tasks done quickly, always using the same methods and/or steps that we
have always used, because it‟s quicker, and we‟re
never really looking at how we could improve on
doing these tasks.
We‟re going to look at some of the basics of the
Legacy program that we use in our genealogy
group. I‟m sure that some of these items will help
improve our computer and genealogical skills. I‟ll
be starting at the opening screen, which we usually
look at briefly, if at all, before we head to the guts
of the Legacy program. This is where we cheat ourselves because we don‟t take the time to stop, look
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and learn.
The first thing I like to see, when starting Legacy, is
the Legacy Home screen. This gets me into that
Stop, Look and Learn frame of mind. If I started
Legacy in any other screen, such as the Family View
screen, I would simply start entering the family data
that I had gathered. Beside the Legacy Home and
Family screens, you can also start Legacy by opening the Pedigree, Descendant, Chronology, Index or
Research screens. You can also decide to open Legacy by going to the last screen viewed when you
closed the Legacy program the last time you used it.
The Options menu, at the top of the window, is
where you can make any one these choices. Click
Options and then click on Customize and go to the
General Tab. The Startup View panel in the General
tabs section is where you make your selection as to
which screen you would like Legacy to start up in.
In addition to starting up in the Legacy Home view,
I also like to see the Tool Tips that Legacy has to
offer and I start them at the same time. In order to
see the Tool Tips, click on the View menu. Click on
Tips Window at the very bottom of the pop up window. You can get to this Tips Window from almost
anywhere in Legacy. If you want the Tips Window
to show up every time you start the Legacy program,
as I do, just select that option at the very bottom of
the Tips Window screen.
Some of the stuff in this Tips Window is pretty
straightforward. You‟ll look at some of these tips
and say, “Gee Whiz” I know that, „cause I‟m already
doing this. Believe me, they are not always that simple. So, don‟t dismiss the feature. Some tips are
quite thought provoking. So much so, that you will
have to use the Show Me button for an explanation.
The Show Me button will guide through whatever
steps are needed to complete the task of that particular tip window.
Another great item in the Tips Window is the
What‟s New button. Every time you update Legacy
the information under this button

BUY YOUR INK a

t:

cfcs.InkRaiser.co

m
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will change. There‟s a lot of new stuff under this button, so take a few minutes to look through “What‟s
New”. For example, in the latest version, Legacy has
added a Best Fit button for the children‟s column.
We used to select one, two or three columns to list
the kids. In days of yore, large families were the
norm. With three columns and five kid‟s spaces in
each column we recorded up to fifteen kids
for a family and we could see all their
names. However, in later years, when we
became more aware of the cost of raising a
family, the off springs became fewer and
fewer. However, if you selected to use fifteen spaces for kids, three columns with
five spaces each, every family got fifteen
spaces even if they only had one, two or
three kids. The best fit button for children will adjust
the columns for each family, depending how hefty
their herd of children is or isn‟t. This gives your family view screen a better look.

information or sources, mostly because I don‟t have
them at the time of entry. I should have, however,
immediately made a To Do list for the item that still
needs my attention, so I don‟t forget it. Alas, I‟m not
really swift doing that either and the item is soon forgotten. This is just what we‟ve been talking about.
Too much to do and not enough time to do it right.
This heftier search options has been a
blessing to me, because it helps me correct
my ineptness.

Another new feature is a beefier search engine. You
can search an entire file for missing information,
such as given names, marriage dates, death dates,
etc. You can also search for missing sources for facts
or events. I know I‟m guilty of not entering complete

Part 2

Now, I can search for the items I didn‟t
have time to do the first time around and
either fill in the missing information or
make a proper TO DO list so I handle
them at a later date.
The Legacy program can help us work quicker and
better if we just take a moment to Stop, Look and
Learn.

This is a continuing article about the Legacy program‟s Home Page. I mentioned in the previous article, which was published in the December 2010 issue
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of Horizons, that our
hectic lifestyle keeps us from investigating all the
amazing features that are included in the software
programs that we use every day. We stick to the
same old tried and true procedures, because it‟s
quick, it‟s easy and it gets the job done. I hope this
article will encourage you the take a little time to
look further and see what your software program(s)
have to offer.
As mentioned in the previous article, to startup in the
Home page window you need to click on the Options
menu item at the top of the screen. In the drop down
menu, click on Customize. In the customize window
are several tabs. You should be at the General tab
view. If not, click on the General tab to bring that
view forward. The very first item, on the left, is
called Startup View. In this section, you can select
one of several views that will tell Legacy which view
you would like to have Legacy start up in. The first
view item is called Legacy Home. This is the one
that I would like you to select if it hasn‟t been already selected. Now go to the bottom of the screen
and select save. From now on, whenever you start
the Legacy program, you will see the Home view
screen with several panels. These panels are as follows, Legacy News, To-Do items, Birthdays, Death
Dates and Anniversaries, Statistics, Updates and
Support. You will also notice a long white bar across
the top of these panels with the word Address in
front of it. This is the same address bar that is in your
browser when you‟re surfing the Internet and is used
in the same way. We‟ll talk about that address bar a
little bit later.
When you open Legacy in this Home view screen
you can connect to the Internet via cable, DSL or dial
up. You will have to tell Legacy how it needs to get
connected. To do that, click on the Options button
near the upper right of the screen. In the drop down
menu, click on Options. In this window are two tabs.
One is called Internet Options and the other is called
Reminder Options. Click on the Internet Options tab
to bring it forward if it isn‟t already forward. The
Internet Options tab gives you two selections to
choose from. Choose the one that is right for your
type of Internet connection and click on save.
Now that you are connected to the Internet and you
have started Legacy in the Home View screen you
can use the Legacy News panel. This panel lets you
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read some of the latest news from Millennia. The
articles in the panel are short excerpts of the full story. If you would like to read the full story, just click
on the highlighted/underlined text and you will be
transported to the Millennia web site. At the Millennia site you can read all or some of the articles and
even add your comments at the end of each article.
You are also given the choice to submit your own
article(s). When you have finished with the Millennia site, simply click on the little house icon that is
just above the address line and to the left. There is
also a little house icon at the very top of the page.
DO NOT click on
that one. When you click on the little house icon you
will be transported back to the Legacy home view
from whence you came.
Below the Legacy News panel are two very interesting panels. One is the To-Do items panel and the other is the Birthdays, Death Dates and Anniversaries
panel. Both of these are reminder panels. They remind you of items that need your attention. For example, when you create a To-Do item for an individual or an event you can fill in a reminder date of your
choosing. As that date approaches, the To-Do item
will be
posted in the To-Do panel as a reminder. You can
also create a reminder for birthdays, anniversaries
and dates of death. In order to create this type of reminder, go to each person‟s information screen,
where births, deaths, occupation, etc., are stored. In
the lower right side of the window are two selections. They are birthday reminder and death date reminder. If you check one or both of these options,
the dates of the checked events will be posted in the
corresponding reminder panel. The same holds true
for anniversaries. Click on the couple‟s marriage
date to bring up their wedding information. At the
very bottom of that window you need to put a check
mark in the Anniversary reminder. Now that you
have the reminders ready to go, you need to do one
more thing. Go back to the Legacy Home view
screen and click on the Option button in the upper
right of the window as you did before. Click on Options in the drop down menu. This time click on the
Reminder Options tab to bring that window forward
if it isn‟t already forward. There are three reminders
listed. Put a check mark in the ones you will be using. Just above these three reminders you will need
to tell Legacy how many days in advance you would
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like to be reminded of these events. Once you‟ve
done that, click save and you‟re all set.

Service Packs Explained (and
needed)

The remaining three panels on the right, Statistics,
Updates and Support are pretty self-explanatory. The
statistics tells you the number of individuals, families
and sources in the family file that you are working
with. The update panel tells you if you are up to date
with the latest version of Legacy. If this panel tells
you that you need to install the latest update, you can
click on that panel to download and update the Legacy program. Whether you update your Legacy program, or not, is your choice. I like to wait at least a
week after an update is out before I install it. This
gives the programmers a little more time to get some
of the bugs ironed out, if there are any. The support
panel has several items in its list. There are two items
here that I feel are of great importance. They are
watch training videos and tips from the experts.
When you choose watch training videos you will be
able to view a video of the basics of legacy for free.
This is a really good training video for all levels of
genealogists. You can also preview all the other videos to see if they meet your needs. Some you can
view for free, while others you can preview before
you decide whether or not to buy it. Clicking on the
Tips from the experts will take you to a very long list
of “How To” instructions. Here is where you can get
tips on a ton of Legacy‟s functions such merging,
split screen view, importing and exporting and so on.
The Tips from the experts go hand in hand with the
help screen that is within the Legacy program and in
most cases will also give you step-by-step instructions.

By Sandy Berger, Compu-KISS
www.compukiss.com
sandy (at) compukiss.com

So, my friends. Don‟t be shy. Dig into what software
you‟ve been using all this time and see what it has to
offer. To my genealogist friends, I wish you happy
hunting.
System Requirements:
Windows 7, Windows Vista, Windows XP, Windows ME*, Windows 98*, Windows NT, Windows
2000 (Legacy runs on newer Macs with Windows
installed under Bootcamp, Parallel or Fusion. Legacy
runs on Linux machines with a Windows emulator
like VMWare or Sun's Virtual Box)
Note: Runs on both 32bit and 64bit Windows platforms.

Although most of us still think of Windows 7 as a
brand new operating system, it is, in fact, starting to
show its age. Windows 7 made its debut on October
22, 2009. Is one and one-half really old? Well, in the
computer world, it is not old, but it is certainly fullgrown. One sign of this is that Microsoft has just released the first Service Pack for Windows 7.
A service pack is a collection of updates, bug fixes,
and enhancements for a software program. As you
know, Microsoft routinely offers updates for their
Windows operating systems. These updates come
out weekly and they patch or, you might say, repair
the operating system so that they remain safe from
hackers. They can also include improvements or enhancements to the operating system. At a certain
point in time, Microsoft gathers all of those updates,
adds any other updates and enhancements they have
and issues this batch of updates as a service pack. It
is also important to note, that when Microsoft issues
a service pack, this service pack also makes sure that
all of the updates and enhancements work well together and offer good stability for the operating system.
The question that I am most often asked is this, "If I
have installed every update that Microsoft has released, do I still need to install the service pack?"
The answer is "yes." Often the service pack contains
additional updates and/or enhancements that were
not included in the weekly updates. Also, a service
pack makes sure that all of the updates are put together properly to make your system run well.
In fact, Microsoft thinks that this is so important that
they only support the operating system when it has
the proper service packs installed. Each service pack
should be installed when it is released. If for some
reason, they are installed all at the same time, each is
installed sequentially.
So, for Windows XP you should have Service Pack 3
installed. Windows Vista should have Service Pack
2, and Windows 7 should have Service Pack 1. To
learn what service pack you have installed, just click
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on the Start button, right-click on Computer or My
Computer, and then click Properties. You will see
the service pack listed under the Windows edition.
You can go to the Microsoft website and install a
service pack from there, if you happen to be missing
one. All service packs from Microsoft are free. If you
are using Window 7, the new service pack will be
offered to you through Microsoft's automatic update
service. This Windows 7 service pack can take up to
30 minutes and will re-boot your computer. I have
installed Window 7, Service Pack 1 on several computers without a problem, but you should be aware
that installing a service pack is a big update. Microsoft recommends that you back up your computer
before installing a service pack. And to be honest,
you should be backing up your computer anyway. So
if you don't have a backup strategy in place, this is a
good time to implement one.
The newest version of Internet Explorer - IE 9 is now
in testing and it is already available for free download in a beta version. This is by far, the best version

of Internet Explorer that Microsoft has ever released.
IE 9 won't run on Windows XP; it requires Windows
Vista or Windows 7. Although Microsoft is not requiring Windows 7 Service Release 1 to install IE 9,
it is advisable to install this Service Release before
you install IE 9.
Service Packs are a fact of life for Windows users.
Installing them may be a bit of a pain, but you really
need them to make sure that your Windows system is
secure and stable and that it performs well.
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7 Little Word Annoyances
and Their Easy Fixes
By Nancy DeMarte, Columnist, Office Talk,
Sarasota PCUG, Inc., FL
March 2011 issue, Sarasota PC Monitor
www.spcug.org
ndemarte (at) Verizon.net
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The University Club
Of
Winter Park

Below is a collection of frustrating things that can
happen when using Microsoft Word. These annoyances can occur in any version of Word although
most are geared to Word 2007 and 2010. In Word
2003, the fix-it steps may be different.
Annoyance 1 -- You accidentally press the Caps
Lock key on your keyboard before typing a paragraph. When you finish, you find everything in capital letters.
The Fix: Rather than retyping the whole paragraph,
highlight the text, then click the "Change Case" button (Aa), located on the Home tab in the Font group.
Click "Sentence case" to transform your paragraph
into normal sentences.
Annoyance 2 -- You create a party invitation with a
light blue background (Page Layout tab - Page Color). But when you print it, the background is white.
The Fix: Office has set Word to not print full page
background colors, probably to save users from
wasting ink. You can, however, make the colored
background print. Click the Office button, then Word
Options -- Display. Put a check mark next to "Print
background colors and images," then click OK. Until
you remove this checkmark, all
colored backgrounds will print.
Annoyance 3 -- You're working
on a document where you've set
the text size to be a fairly small 10
points. But you find that the text is
too small to view comfortably
while you're typing.
The Fix: Drag the Zoom slider
located in the bottom right corner
of the Word window to the right to
enlarge the screen view of the text.
When printed, the text will be 10
points no matter how big it appears
on the screen.

Join us for Fellowship,
Cultural Enrichment, Intellectual Activity,
and
Community Betterment
The University Club of Winter Park
841 Park Avenue North
Winter Park, FL 32789
407-644-6149
www.uclubwp.org

The University Club audience pays rapt attention during the Skype presentation.
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Review tab.
Annoyance 4 -- You find that the spaces between
lines of text in your document are wider than you
want.
The Fix: If all the spaces are wider than expected,
you can change the line spacing for the whole document at once. On the Home tab, in the Editing group,
click Select -- All to highlight all the text. Next click
the Line Spacing button in the Paragraph group and
select 1.0 for single-spacing or one of the other
choices.
Note: Word will not remove extra space after paragraphs when you choose a line spacing size. To remove extra space after a paragraph, select the paragraph before the extra space, click the Line Spacing
button and choose "Remove Space After Paragraph."
A more permanent way to create no extra space between paragraphs is to open the Paragraph group dialog box launcher (small diagonal arrow) on the
Home tab and put a checkmark in front of "Don't add
space between paragraphs of the same style."
Annoyance 5 -- Every time you type an email or
web address into a document, it turns into a clickable
hyperlink with underlined blue text, even if that isn't
your intention.
The Fix: The quickest fix is to right click the address
and select "Remove Hyperlink." But this is only a
one time remedy. To remove this action permanently, click the Windows button, then this sequence:
Word Options -- Proofing -- AutoCorrect Options -AutoFormat As You Type. Remove the checkmark
next to "Internet and Network paths with hyperlinks"
and click OK.
Annoyance 6 -- You find that as you type, distracting wavy red and green lines show up under words
and phrases.
The Fix: Word is set to check spelling (red lines)
and grammar (green lines) as you type. This is another Proofing option which comes enabled from the
factory. To turn off one or both of these features, go
to Word Options (Office button - Word Options) and
click Proofing. Remove the checkmarks next to
"Mark grammar errors as you type" and "Check
spelling as you type." You can always check spelling
and grammar after your document is complete by
clicking Spelling & Grammar at the left end of the

Several of these fixes involve the settings found in
the Options area of the Office 2007 menu (File menu
in 2010). Options are available for all the Office programs (Word Options, Excel Options, Access Options, etc.) These default settings were determined by
interviews with thousands of people who use Office
regularly in the workplace. If you find that the factory settings are causing you more trouble than help,
changing them is a simple task. All Office users
should take a personal tour of the Options menus,
which resemble this Word Options window with the
AutoCorrect box open:

Annoyance 7 -- You often save documents to the
same folder which is buried within other folders in
My Documents. It takes several clicks to find this
folder each time you want to open or save a document to it.
Fix 1: You can find almost any folder on your Windows Vista or 7 computer by typing its name into the
Start Menu search box just above the Start button.
Often it takes only a letter or two before the folder
appears in the search results. On the downside, you
have to do this each time you want to open the folder.
Fix 2: A way to make any folder immediately available is to add it to the Favorites section of the navigation pane. This pane appears on the left side of any
explorer window where you are viewing, opening or
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saving files and folders. To make a folder a Favorite,
start by creating or opening a file, like a document,
and click Save As, which opens the Save As dialog
box. This reveals the navigation pane on the left,
showing a list of possible places to save the file.
Navigate to the folder you want to make a favorite so
that it is the last item in the history bar across the top.
Then right click the word Favorites in the left pane.
From the drop down menu, click "Add current location to Favorites." Your special folder will now appear in the Favorites list. It will also appear in the
Favorites list of the other MS Office programs on
your computer, such as Excel and PowerPoint. To
remove a folder from Favorites, right click the folder
and select Remove.
Using a computer should be fun as well as useful.
Take a few minutes to think what your personal computer annoyances are and try to find fixes for them.
Customizing your programs makes using the computer much more enjoyable and efficient.
(Approx. 586 words)

Cell Phone Lingo
By Wil Wakely, President, Seniors Computer
Group, CA
March 2011 issue, Bits and Bytes, The Official Electronic Newsletter of the Seniors
Computer Group
www.SCGsd.org
wilw(at)adnc.com
When it‟s time to buy or upgrade to a new cell
phone, are you as confused as I am with all the fancy
terms and acronyms in the sales pitch? They make
my head spin. Some of the terms you will encounter
refer to the technology generation of the phone, as in
G0 to G5. About every 10 years the next larger G
(generation) number appears denoting a major improvement in cell phone technology. Each generation
improves the speed, security, power usage, range and
reliability of cell phones.
G0 refers to the original mobile telephone, a large
unit stored in the car trunk with a hand-set between
the driver and passenger seat. Remember those? Essentially it was a souped-up short-wave radio. These
first made the scene via Motorola and Bell Telephone in the 50‟s.
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Next came G1 using GMS tech (see below) which
also was analog, first introduced in Japan in 1979
and later in the USA in 1983. In 1992, G2 was a major improvement using digital technology vs. analog
that was used in G1. So what‟s the difference? Analog is a continuous smooth signal like whistling a
tune. Digital rapidly samples the song and converts
each small time segment into a series of ones and
zeros, or digits. Through some clever complex calculations, these digits are converted back to the original
sound tone and volume. The advantages of digital are
that the data can be compressed and encoded for security and no information is lost as long as the 1/0
signal can be detected, even from a lot of accompanying noise.
In 2001, 3G was introduced using a new technology
called CDMA (code division multiple access) developed by our local Qualcomm company. This is a
very complex encoding that allows many more users
on the same channel at the same time.
G3 is probably the most common system in use today.
G4 arrived in 2006 and allows 1 Gbt/s (one gigabit
per second) downloads from a fixed location or 100
mbt/s (megabits per second) from a moving vehicle.
These high speeds allow streaming high-definition
video (HD movies) on your cell phone. Also, connections to the Internet are faster and better. G5 is
still in the lab and promises even more features, but
may not arrive before 2020.
The cell phone field is rampant with 3, 4, and 5 letter
acronyms. Here are a few that a salesman may try to
impress you with:
GMS (global mobile system): still widely used in
older phones.
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TDMA (time domain multiple access): sharing the
airwave in small time slots.
FDMA (frequency domain multiple access): sharing
the airwave in different frequencies.
CDMA (see above).

studio in your notebook computer. This is a great
idea that I have used and really like the results. Pick
a picture to show on the screen of your laptop. Use
two LED lamps that plug into a USB port. Cover the
keyboard with something that has a smooth finish.

An analogy to the problem of multiple access is a
room (channel) in which people wish to talk to each
other simultaneously. To avoid confusion, people
could take turns speaking (time division), speak at
different pitches (frequency division), or speak in
different languages (code division). Other terms you
may encounter are LTE (long term evolution),
OTDMA (orthogonal TDMA) and WiMax (similar
to WiFi). These are fancy names for some of the latest improvements in the field. So the best strategy for
buying a new cell phone is to read the reviews and
then find a salesman you can trust. Some of
the above information may help you understand his
pitch and also impress him with your knowledge.

I took pictures of flowers and jewelry. It is such a
great idea.

The Wild Side of Photography
By Clara Harold, Member, Tucson Computer
Society, Arizona
March 2011 issue, TCS eJournal
www.aztcs.org
cbellevideo (at) msn.com
This book‟s twenty chapters are written by 11 different photographers. They hail from around the world
and show great imagination and creativity.
1. Landscape Blurs – Alain Briot. Notes on process
and approach. Alain talks about the equipment that
he uses, picking the right scene with the right colors
and the quality of light that will make a beautiful
blurred photo. He writes about picking the correct
lenses and processing your photo in Lightroom 2 and
Photoshop CS4.
2. Landscape Blurs, part 2 – Alain Briot. Image processing Workflow. The photos of the workflow he
used in Lightroom 2 are well done. He talks about
the Black Point Adjustment Curve which was very
helpful in editing pictures with great results. The instructions on how to use the High Pass Filter,
Smudge Tool, Shadows, Highlights and Vibrance
adjustments and what they do are very good.
3. Show Time – Gerhard Rossbach. A mini photo

4. Near and Far – Cyrill Harnischmacher. Using telephoto and macro lenses as telescopes and microscopes. Cyrill explains how to build with eye pieces,
adapters, and customized lens caps and even how to
adapt a compact camera into a homemade telescope.
Use some old camera equipment to experiment with.
5. Camera Obscura – Tobias Pohl. Analog and Digital Pinhole Cameras. After sharing some of the history about the pinhole camera he gives information on
how to build one as well as suggestions on how to
correct some of the problems you might encounter.
He suggests www.pinhole.cz.
6. Graffiti Made of Light – Niklas Plessing. Light
Writing with LED Lamps. Niklas writes about equipment and sources of light for getting great shots. He
goes into great detail about camera settings so you
can be sure to capture a good photo. There are 6
websites listed for more information on light writing
and equipment.
7. Kite Aerial Photography – I have never flown a
kite, so I don‟t think I will try this one. They describe
the different kinds of kites, everything you will need
to get started, plus a long list of websites on the subject.
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8. Selective Focus – Cyrill Harnischmacher. Build
Your Own Tilt/Shift Lens. This chapter is how to
modify an old camera. The directions for all the technical work are listed. There are some pictures of
some very interesting results from the makeover.
9. Color, blur, and Verve – Anett Boettcher. Closeup Photography Revisited. The author likes to experiment with camera lenses to keep his work intriguing; he experiments with color on the computer so
the viewer will want to take a second look. There are
very nice examples of his work.
10. Diver Down – Kai Wallasch. A look at the fascinating world of underwater photography. There is a
lot of good information about equipment and how to
use it. For the more practical photographer he shows
how to build a periscope.
11. Night Sights – Michael Diechtierow. Using
flash creatively in the dark. First you need a camera
that is capable of long shutter speeds and high ISO
settings. He goes into great detail on using light and
various flash techniques, with some great pictures as
examples of his work.
12 . The Sun, the Moon, and the Stars – Cyrill
Harnischmacher. Simple ways to shoot spectacular
astrophotos. He explains about using the top hat
method to avoid camera shake, focusing, the right
place and the right time. A list of exposure settings is
provided along with f stops and how to build your
own sun filter. If you are planning on taking night
pictures this book would be of great benefit.
13. Klip-Klap – Tobias Pohl. Getting started with
stereoscopic photography. Design drawings are
available in the book to build your own attachment to
use on your tripod. This gives you a very artsy effect.
14. The Flatbed Camera – Gottried Huettemann.
Taking photos with scanners. There are directions on
how to get great photos of small objects without a
camera. Information is given on how to set up the
scanner and how to block out the light.
15. What Do You Print On? – Michael Benecke.
Printing images on unconventional materials. He
gives a lot of information about different printers and
explains the many different types of paper. It is
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amazing the incredible variety of papers that can be
found on the web. For a little fun, you can print on
edible paper, apply it to a wafer and frame it!
16. Gotcha! – Cyrill Harnischmacher. High-Speed
photography using a photoelectric shutter release.
This chapter has information on how to take very
high speed photos of water splashing and eggs breaking, the equipment that is needed and what settings
to use.
17. Soft-Focus Lens – Mike Hagen. Create a Lensbaby Effect with Vaseline. To take pictures with a selective focus using what you have at home, try a little
Vaseline. You can try horizontal, radial, partial, diagonal or circular smears. Use your imagination. When
it‟s time to clean your filter, use a little rubbing alcohol on a soft rag.
18. Little Planets – Christian Bloch. Seriously twisted panoramas. This technique needs some special
equipment. An HDRI book by the author is available
at www.hdri-handbook.com. You may also consider
Mastering Digital Panoramic Photography by Harold
Woeste,
see
the
site
http://oreilly.com/
catalog/9781933952451. The photos featured in the
book are outstanding.
19. Light Changes Everything – Martin Krolop. Using Dedicated Flash Professionally. Here‟s information on all types of flash units that can be used,
from in-camera flash to accessory units that allow
photographers to enhance their subjects anywhere.
He gives advice on both indoor and outdoor shooting.
20. A View From Above – Mike Hagen. Aerial photography with a telescoping monopod. Want to raise
your camera 20 feet into the air. Information on how
to construct you own telescoping monopod is in the
chapter. He gives a list of what you need and how to
use it for a very low price. Use the self timer and
you‟re in for some great pictures.
21. Camera Hacking – Berthold Daum. Activating
hidden functionality in Canon Consumer Digicams.
He explains how to bring up a lot of hidden information that is in your camera.
This book will help you be more creative and take
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your photography to a higher level. There is something for all ages and ability levels. I recommend this
for every photographer‟s library.
About: The Wild Side of Photography
Author: Various
Publisher: Rocky Nook
www.rockynook.com
ISBN-10: 1933952512
ISBN-13: 978-1933952512
Price: $29.95, $19.57 @ Amazon

A Free Apple a Day
Keeps the Doctor Away
By Larry Anders, Member, Tampa PC Users
Group, FL
www.tpcug.org
Larry (at) anders.net
I had been highly opposed to Apple products for
years because of what I feel to be the smallmindedness of Steve Jobs and the Apple management by not making their code available to developers, which would allow software to be developed so
there would be more choice at reasonable prices. If
so, I'm sure there would be a Mac in my house instead of just seven PCs running various Windows
operating systems.
Above, you'll notice I said "had" been. Then I purchased my first iPod, and I was hooked! I did not get
the first version iPhone, but I have had the 3GS now
for almost
two years. It is about the 10th cell phone I've owned
and by far the very best. I have been tempted to try
an Android phone but so far have had no reason to
give up the iPhone. The Apps for the iPhone make it
an everyday challenge to find something useful, and
typically for free. Why Mr. Jobs can't see that allowing all these people to develop software for the iPod/
iPhone/iPad has made his products extremely successful is beyond my understanding. He has still kept
control by not allowing anything to be installed except through the iTunes App Store. Even the free
Apps. If something similar was allowed for the Mac,
I think he would see the popularity of the Mac increase also. I just can't validate paying twice the
price for software just because it's a Mac. It's good,
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but not that good.
For Christmas I was given an iPad by my wife and
kids. Now, you want to talk about what I think is the
best invention of the 21st century. Since December, I
use my PCs at least 50% less. My iPad sits next to
me on the couch when it is not in my hand. Email,
Messenger and text messaging is with me now wherever I am, between the iPad and iPhone. The two are
very similar, but the 9" screen on the iPad is much
easier to read and work with.
The iPad comes with several built-in Apps, such as
Calendar (to track your appointments), Notes (to
keep lists of things), Maps (complete Google maps),
Videos (to watch your favorite videos), YouTube,
iTunes, App Store and Games. They also include Safari (Apple's Internet browser), Email, Photos (access
to your photos, graphics and screen captures), iPod
(for music) and Contacts. That's plenty to keep you
going until you learn how to start downloading some
of the thousands of Apps available, with more coming every day. If you're into anything, there is probably an App for it. Also, there are free Internet musicstreaming sites that will allow you to listen to any
kind of music whenever you want, with no hiccups.
The battery is excellent. With my constant use, I still
get two to three days between charges, and the recharge is very fast.
Apple has also released iBooks, which will probably
be a permanent fixture in the next iOS upgrade. In
my opinion, it's one of the better (free) eBooks reader programs.
If you're used to using Kindle, Google or any of the
other readers, there is an App out there for that, too. I
downloaded a free App the other day that makes
23,469 classic books available at your tap. And I did
say free.
One App I especially like is the Dragon Speaking
App, for both the iPhone and the iPad. There is no
need to type. Just start the App, push Record and
start talking. It recognizes when you stop, allows you
to insert commas, periods and new paragraphs. When
you're done with the dictation, tap Copy, then paste it
wherever you want, or tap Email and it will send it
directly into your email. Oh yeah, did I mention it
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was free?!
The iPad does not come with a text program, like the
iPhone, but there are several free Apps that will take
care of this problem. I use one that I am more than
happy to pay for but see no reason to do so as the
developers do not ask me to. There is a small nonintrusive ad area in the lower left corner and that's it.
The same with Messenger.
I am currently using Dragon Speaking with a free
App called Documents to create this article. Documents allows you to review and edit Word and Excel
documents. I wouldn't expect to be able to work on
some gigantic files. I expect a version of Word and
Excel to be out soon, assuming Apple will allow a
Microsoft App to infiltrate their domain.
Another thing I am really pleased with are Apps
available for our younger computer users. My daughter and son-in-law both have iPads, so my 5-year-old
granddaughter is well-versed on using the iPad. I
typically get her to teach me some secret thing when
she comes over on the weekends. I spent a lot of
money for the overhead movie system in my Tahoe
for her to be able to watch movies, etc., when we are
in the car. Lately, though, she would rather have my
iPad while we are driving around. There are some
excellent educational Apps (free, of course) that help
teach her to read, do math, draw and all sorts of other
things.
In any case, as I have thanked Bill Gates and the
team at Microsoft in the past for making computing
enjoyable with Windows, I now need to thank Steve
Jobs and the gang at Apple for heading in a new direction and once again making computing enjoyable.
I can't wait for the 22nd century to get here!
Sent from Larry's iPad.
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Add Text on a
Photo in Word 2007
By Lynn Page, Editor, Crystal River Users
Group, Florida
December 2010 issue, CRUG newsletter
www.crug.com
newsletter (at) crug.com
When creating a document it may be useful to place text with or
on top of a photo. You could create a new photo with the text in
a digital photo editing application and then save it for use. But
if you will just use that image once why go to the bother. Within Word 2007 you can add the text on top of your photo using
either WordArt or a text box.
Which method to use depends on the effect desired. For text
that is short and an interesting stylized look is what you want
WordArt is a good option. For plain and simple text a text box
can match the text to that in the rest of the document.
Text Box on Top of a Photo
Placing a text box on a photo can be as easy as inserting the
photo, creating a text box and dragging the text box onto the
photo.

To add a photo to a document place the insertion point in the
document where the photo is to be located and click the Picture
icon in the Illustrations group on the
Insert tab. Browse to the photo in the Insert Picture dialog box,
select it and click the Insert button.
To place a text box on the photo first create the text box. Place
the insertion point on a line below the photo. Then in the Text
group on the Insert tab, click text box and then click to select
Simple Text Box. In the inserted Text Box type the text. To
change the font or style of the text, highlight the text and then
select the desired text formatting as with any other text. Drag
the text box sizing handles to resize it as necessary. Finally
click the outside edge of the text box and drag it to the proper
location on top of the photo.

Support our Advertisers.

Tell them
you saw their ad in the CFCS Newsletter!
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handles to resize as desired. Click the outside edge of the
WordArt to select it and drag it over the photo. Use the rotation
handle to rotate the text to the angle that works best for the photo.

The default Text Box will have white fill and a black border.
For use over a photo you will probably want no fill color or
border. With the Text Box still selected click Text Box Tools
and on the Format tab, in the Text Box Styles group, click
Shape Fill and select No Fill. Then click Shape Outline and
select No Outline.

Once the graphics are correctly formatted and positioned group
them. That creates a single graphic that can be moved or
resized. The text stays with the photo. To create a group click
the outside edge of the photo, press and hold the CTRL key,
and click the edge of the WordArt so both items are selected.
Under Drawing Tools, on the Format tab, in the Arrange group,
click the arrow next to Group, and then click Group.

With the Text Box you can add text on top of a photo and move
the text to position it over the photo, but you can't rotate it. To
be able to rotate the text or use text that is more stylized use
WordArt.

WordArt on Top of a Photo
To place WordArt on the photo first create a Drawing Canvas.
Place the insertion point in the document and then in the Illustrations group on the Insert tab open the Shapes drop down
menu and click New Drawing Canvas.
With the new drawing canvas still selected on the Insert tab, in
the Illustrations
group, click Picture. In the dialog box browse to and select the
photo to use and click the Insert button. Again on the Insert tab,
but in the Text group, click WordArt, select the style desired,
and type the text. Select either piece of art and use the sizing

Be a smart guy. You could pay your yearly
dues to CFCS simply by making computer
related purchases at Smart Guys Computers.
Buy a laptop, get free dues!
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eBook Readers Compared
By Constance Brown, President,
Canton/Alliance/Massillon User Group, Ohio
February 2011 issue, The Memory Map
www.camug.org
president @ camug.org
Technology with new capabilities and applications is
constantly available. It can be difficult to stay focused on what will be most suitable for our requirements when we are constantly wowed by the latest
innovations. Suppose you wish to read eBooks and
listen to music. How many pieces of equipment will
allow you to do this? Here are a few:
computer, web book, a variety of phones, iPad, some
mp3 players, some GPS devices and some eBook
readers.
The cross application of many of these devices is
amazing and sometimes confusing. In January we
heard a presentation from the Stark County District
Library about eBooks and eAudio books and were
introduced to a variety of devices that can be used to
check out these Books. The library has a links to lists
of compatible and incompatible devices at http://
www.overdrive.com/Resources/DRC/Default.aspx.
During the presentation, I became interested in the
comparison between Apple‟s iPad and Barnes and
Nobles Nookcolor. Both of them have one disadvantage when compared to other readers such as other Nook products, Sony, Kobo or Kindle: the screen
is not E Ink or E Paper.
That means the battery is being drained when it is in
use and that it will be more tiring to the eyes and perhaps impossible to read in bright light. However,
Nookcolor lets you read books and a magazine in full
color and works both in Wi-Fi and 3G networks. It
has
8 Gig of internal memory, enough to hold 6,000
books, and is expandable to 32 Gig. Over 2 million
book titles are available, and it has internal support
for Microsoft Word, Excel and PowerPoint.
Additional features include resizable text and
graphics with AliveTouch™, audio, Read to Me,
Keep your last page, read between devices,
LendMe™ technology, borrowing, and you can share
updates on Social sites like Facebook® and Twit-
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ter®. It runs with the Android™ Operating System.
The price tag is $249. More information is available
at http://www.barnesandnoble.com/nook/index.asp.
Here the comparison stops. Nookcolor was not designed for Internet browsing or communicating via
email.
Apple‟s IPad comes with 16 Gig to 64 Gig of internal memory. Some IPads are Wi-Fi only and others
are either 3G or Wi-Fi. The price tag varies from
$499-$829. The IPad is much more than an eBook
reader. It offers Internet access and applications. It is
still awaiting an app to be released that will let the
reader view eBooks full screen. You can page
through websites, write an email, flick through photos, or watch a movie with just the touch of a finger.
The 3G data plan is through ATT and starts at $14.99
per month. It has many computer capabilities, especially when it comes to browsing the Internet and
reading email.
When it comes to comparing eBook readers that use
E ink and E paper, it is a bit more difficult to make a
selection. The Kindle is great, but doesn‟t allow for
you to check out eBooks from the library at this time.
Kobo from Borders does not allow you to listen to
EAudio and requires that books be loaded from a
computer. Sony and Nook have their own trade-offs
with weight, bulkiness, and a screen that is sometimes difficult to read in sunlight in the case of the
Sony. So if an E Reader is in your future, you will
have to select what best meets your needs. Having an
eReader certainly beats having to carry heavy, bulky
books through the airport in order to satiate your
reading appetite as you
wait for your next flight!

Arvin uses the IPod as an eBook reader.
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HelpLine
HelpLine is a free service to members of CFCS only. The following volunteers have offered to field questions by phone or via email with software and hardware problems listed below. Please be considerate of the volunteer you are calling.
As a free service, you should not be asked to pay for help or be solicited for products or services. If anything to the contrary
occurs, please contact the HelpLine coordinator immediately. Their names will be removed from the list.
Additional volunteers are needed in some existing categories and for new categories. If you are interested, please contact the
HelpLine coordinator at e-mail: helpline@cfcs.org

Please Note - This is a service for CFCS MEMBERS ONLY
Digital Photography & Video
Ken Larrabee
407 365-2660
anytime
KLarrabee@cfl.rr.com
DOS
Stan Wallner
407-862-2669
smwallner@yahoo.com

5 pm-7 pm

407-365-2660

Stan Wallner
407-862-2669
smwallner@yahoo.com
MS ACCESS
Arvin Meyer, MVP 407-327-3810
Access-sig@cfcs.org

407-327-3810

vp-adm@cfcs.org

Networking - Home or Office
Doug Gabbard
e-mail only
Dougga@gmail.com

407-327-3810

vp-adm@cfcs.org

Windows
Hewie Poplock
hewie@hewie.net

WinZip
Arvin Meyer
anytime
5 pm-7 pm

7 pm - 9 pm

MS Office Products:
MS Word, Excel, Power Point, Outlook and Access
Doug Gabbard
(e-mail only)
Dougga@gmail.com
Security
Arvin Meyer

SQL-Server
Arvin Meyer

407-362-7824 5 pm-7 pm

Kris Hestad
321-459-2755
kris.hestad@surfdogs.com

Kris Hestad
321-459-2755
kris.hestad@surfdogs.com
Hardware
Ken Larrabee

HelpLine Listings

407-327-3810

vp-adm@cfcs.org

Wireless Routers
Kris Hestad
321-459-2755
kris.hestad@surfdogs.com
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◄ Mar 2011

Sun

Mon

Tue

~ April 2011 ~
Wed

May 2011 ►

Thu

Don’t forget that the General Meeting on April 17 is back at the
Jackson Hewitt offices on Lee Rd. See April’s BUSSLINE or
cfcs.org for directions.
3

4

5

6
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Fri

1

Sat

2

Newspaper
Copy deadline

7

8

9

14

15

16

21

22

23

28

29

30

CFCS BoD
Denny’s
Casselberry
7 pm

10

11

12

13
Access, Office,
Security
SIGs:
New Horizons,
Lee Rd. 7 pm

17

18

12:30 pm
Windows SIG
2pm
General Meeting

iPhone SIG, Lee
Rd. Denny’s,
7 pm

19

24

25

20
Photo/Video SIG
New Horizons,
Lee Rd. 7 pm

26

27

Tech SIG
Denny’s,
Casselberry
7 pm

~ May 2011 ~
Wed

◄ Apr 2011

Sun

1

Mon

2

Tue

3

4

Jun 2011 ►

Thu

Fri

Sat

5

6

7

12

13

14

19

20

21

26

27

28

7pm CFCS BoD,
Denny’s
Casselberry

8

9

10

11
Access, Office,
Security SIGs:
New Horizons

15

16

12:30 pm
Windows SIG
2 pm
General Meeting

Phone SIG, Lee
Rd. Denny’s, 7
pm

22

23

17

18
7pm Photo/Video
SIG New Horizons,
Lee Rd.

24

25

7pm Tech SIG
Denny’s,
Casselberry

29

30

31

Notes:
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DIRECTIONS TO MONTHLY MEETING
Our meeting building is at the intersection of
Lee Road and Turner Rd. The meeting is in the
building behind the one on the corner of Lee
and Turner. Turn North on Turner, left into the
parking lot, and drive behind the office building
in the rear of the parking lot. You will see a sign:
Jackson Hewitt delivery entrance. Plenty of
parking is nearby, and the meeting room is just
inside, making it accessible for those with special mobility equipment.
SPECIFIC DIRECTIONS
based on your starting point.
From I-4, exit at lee Rd., drive East 1/2 mile
to Turner Rd. and turn left onto Turner and
left again into the first parking lot. Drive to
the rear of the rearmost building and look for
the Jackson Hewitt delivery entrance.
From Apopka/436 area, go south on 441 to
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Lee Rd., Go about 2 miles, past I-4, then turn
left onto Turner and left again into the first
parking lot. Drive to the rear of the rearmost
building and look for the Jackson Hewitt delivery entrance.
From the SouthWest, take John Young to
Lee Rd. as above, turn left on Turner and left
again into the first parking lot. Drive to the
rear of the rearmost building and look for
the Jackson Hewitt delivery entrance.
From Hwy 17-92, drive to Lee Rd, turn West,
then go 8/10ths of a mile to Turner Rd. and
turn right. Drive to the rear of the rearmost
building and look for the Jackson Hewitt delivery entrance.
PARKING is FREE!
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